PAGINA |1

11. ESTIMATIVA DE PRECIPITACAO A UMA REGIAO DE
INTERESSE:
APLICANDO COSCH AS IMAGENS DE SATELITE E
DADOS DE PRECIPITACAO.

By: Cesar Luis Garcial e Daniel Vila 2

11.1. Importancia do trabalho de pesquisa

A distribuicdo espacial e temporal da precipitagdo numa base regional é necessaria para uma variedade de
aplicagdes cientificas e sociais, tais como: estudos e diagnostico do clima, gestdo da &gua para agricultura e
energia, mitigacéo da seca, controle de enchentes e previséo da producéo de culturas e eventos extremos. Um
aspecto muito comum do monitoramento hidrolégico nos paises em desenvolvimento é a baixa densidade das
redes de medicéo de chuva. Nas situacdes extremas como a seca e 0s periodos de inundacéo, a falta de dados
acrescenta o desafio das instituicoes responsaveis pelo controle e alerta, e ocasiona uma reducéo da eficiéncia na
tomada de medidas. Em situa¢es normais, a disponibilidade de informacdes hidroldgicas pode ajudar a
melhorar a produtividade da terra, permitindo uma melhor gestdo do mercado e das atividades produtivas.
Portanto, as informacdes hidroldgicas disponiveis sdo percebidas como um recurso valioso, mas a tarefa de
quantificar a distribuigdo da chuva é complicada pelo fato de que no momento nao ha um método de estimativa
de precipitagdo com a cobertura e precisdo necessérias.

Nossa proposta é desenvolver um aplicativo capaz de utilizar os recursos do sistema de difusdo DevCoCast, ou
qualquer outra alternativa de satélite, associada a dados de precipitagdo para construir um produto misto que faca
uma estimativa da precipitagdo com baixo nivel de distorcéo.

A estimativa de precipitagdo diaria, usando um algoritmo que permite incorporar informacdes de redes de
satélites e de redes pluviométricas envolve dois passos fundamentais: primeiro, a definicdo de um algoritmo para
estimar a precipitagdo usando satélites; e, em segundo lugar, definir uma técnica de fusdo para incorporar
informacdo pluviométrica. No primeiro caso, usando o algoritmo "Hydroestimator" (Vicente et al., 1998) sobre o
satélite GOES como a base para a estimativa de precipitacdo. Este produto esta disponivel sob a sigla "RFS"
(Rainfall Satellite) dentro do fluxo de dados do sistema GEONETCast fluxo de dados. A segunda questéo tem
sido amplamente discutida em varios artigos nos Ultimos anos, e a crenca geral é que as observagdes
pluviométricas oferecem uma menor distorgdo. Portanto, elas substituirdo quaisquer estimativas de satélite em
regides com uma rede pluviométrica densa, enquanto em areas sem dados terrenos ou nas grandes massas de
&gua, as estimativas de satélite terdo maior peso no produto final.
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11.2. Objetivos do aplicativo

Seguindo, 0s objetivos do aplicativo:

1. Desenvolver um produto, mapa de precipitacdo diaria, baseado na combinacédo da estimativa por satélite
e dados de uma rede pluviométrica através da técnica CoSch (Combined Scheme technique, Vila et al.,
2009);

2. Estabelecer um método para calcular estatisticas das chuvas que ocorrem em qualquer regido de
interesse (ROI pela sigla da expressdo “Region of interest”) proposta pelos usuérios. Isso inclui o
calculo de: precipitacdo média areal por bacia, precipitacdo méxima do dia, area com precipitacbes >
1mm, e precipitacdo média areal considerando apenas as areas com mais de 1 mm

3. Fornecer os usuarios do sistema GEONETCast de uma funcdo automatica para processar e obter
produtos diarios a partir da informagcdo em tempo quasereal. Ha previsdo de gerar os seguintes
produtos: Precipitacdo didria estimada a partir das imagens RFS de 15 minutos e Estimativa da
precipitacdo diaria corregida por o método CoSch.

Este aplicativo pode ser utilizado em forma manual, batch (processamento por lotes) ou em forma automatica. A
aplicagdo manual deste procedimento, passo a passo, € a melhor forma de entender como funciona o método
selecionado, devido a isso, neste capitulo se explicard para um dia especifico em toda sua extensdo. Este
procedimento pode utilizar-se na modalidade batch para processar series temporais de imagens. Para 0s usuarios
do sistema GEONETCast a modalidade automatica pode ser utilizada para obter resultados diarios diretamente
do fluxo continuo dos dados do satélite.

11.3. Dados utilizados

11.3.1. Limite geografico e temporal do aplicativo

O desenvolvimento préatico deste aplicativo serd levado a cabo dentro dos limites geograficos do produto RFS
distribuido pelo INPE dentro do sistema DevCoCast. Para realizar o exercicio se fornece uma ROI constituida
pelas principais bacias hidrolégicas da América do Sul. Como fonte de dados pluviométricos se utilizou um
conjunto de dados diarios, gratuitos e disponiveis livremente para todo o mundo. Isto facilita a implementagéo
deste exercicio em outras areas geograficas e determina una resolugdo temporal diaria. Ndo entanto, é
conveniente clarificar que este aplicativo e a metodologia CoSch (Vila et al., 2009) podem ser adaptadas a
qualquer: ROI, produto de estimativa por satélite da precipitacéo, localizagao e resolucéo temporal.

11.3.2. Dados locais e/ou regionais (terrenos)

Os dados locais ou medigBes que sdo necessarios para este aplicativo sdo os dados pluviométricos. A
metodologia CoSch para estimar a distribuicdo da precipitagdo permite uma maior eficiéncia ao incorporar
informacdo de distintas fontes (fornecida pelo satélite e obtida na terra). Para este exercicio a informacéo
pluviométrica é obtida do NOAA’s Climate Prediction Centre Unified Gauge-Based Analysis of Global Daily
Precipitation. Este conjunto de dados € de acesso livre e gratuito através do site:

ftp://ftp.cpc.ncep.noaa.gov/precip/CPC _UNI PRCP/GAUGE_GLB/.

Este conjunto de dados posei uma cobertura global a uma resolucéo espacial de 0.5 graus, e tem informagéo
desde 1 de janeiro de 1979 até hoje.

Embora a informagdo é levada para um mapa interpolado de todo o mundo, este é baseado em informagdes de
30.000 pluviémetros na versdo retrospectiva (1979-2005) e 17.000 para a versdo em tempo real (2006 até o
presente).
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Para cada dia estdo disponiveis 2 imagens georreferenciadas: 1.- Precipitacdo diaria por pixel, 2.- NUmeros de
estagcBes pluviométricas com dados dentro de cada pixel. Devido a que um pixel pode conter mais de um
pluviémetro ou nenhum, cada pixel terd um valor médio ou interpolado que represente seu comportamento
segundo o comportamento de seus vizinhos. Para levar a cabo este exercicio os pixeis que ndo contém
pluviémetros serdo removidos da analise. Isto é porque seu valor ndo esta baseado numa observacao, e portanto
ndo pode ser considerado para corrigir uma distor¢do da estimativa do satélite.

Outro dado local que deve providenciar o usuario é a area de interesse sobre a qual calcular as estatisticas de
precipitacdo. Em o nosso exercicio s&o as bacias mais representativas da América do Sul.

11.3.3. Dados do sistema GEONETCast — DevCoCast (através dos satélites)

Os dados utilizados neste aplicativo séo parte do fluxo de DevCoCast América. O produto é enviado pelo
CPTEC - INPE e publicado com o nome “Rainfall Satellite - RFS”. Os dados sdo uma imagem em formato
GEOTIFF, com um tamanho aproximado de 200KB, com uma resolucdo temporal de 15 minutos e uma
resolugdo espacial de pixel de 4km. Basicamente, 0 RFS é o resultado da aplicacdo e adaptacdo de uma verséo
melhorada do algoritmo “Hydroestimator” para transformar os canais térmicos do satélite GOES East em
precipitacéo.

11.4. Metodologia

O esquema proposto, Combined Scheme (CoSch), combina em apenas um método dois enfoques diferentes para
minimizar a distor¢do da estimativa dos satélites. Assim, este método supera as limitagdes que cada abordagem
pode ter separadamente e produz mapas de precipitagdo com campos continuos. A Figura 11,1 mostra o
diagrama de fluxo do presente processo.
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Figura 11.1 Processo metodoldgico deste aplicativo

A correcdo adicional da distor¢do (ADD) é definida da seguinte forma:

ADD = rr_sat + (rr_obs —rr_sat) Eq.1

Onde rr_sat é o valor estimado por o satélite e o segundo termo representa a distor¢éo adicional média local para
um conjunto de pixeis entre a precipitacdo observada (rr_obs, CPC neste caso) e estimada pelo satélite (RFS,

neste caso).

A correcdo proporcional (ratio) da distor¢cdo (RAT) é definida como:

RAT =rr_satx

rr_obs
rr_sat
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Onde aplica a mesma convengdo que no caso da corre¢do adicional.

Quando no héa informacao pluviométrica, se mantém o dado estimado por meio de satélites. Porém, para areas de
influéncia dos pluviémetros analisa-se a diferencia entre as corre¢des de distorgdes ADD e RAT. Uma
abordagem particular é utilizada para realizar a correcdo nessa area de influéncia baseada na menor diferencia
entre aquilo que é observado e aquilo que €é estimado por cada enfoque.

Ap0s de obtido um mapa de precipitagdes diarias baseado na combinacdo mais dos dados de entrada, realizam-se
as analises estatisticas para nossas regides de interesse (ROI) e exportam-se a uma tabela.

11.5. Analise de dados

11.5.1. Pré-processamento dos dados de entrada

Antes de comegar a analise dos dados ha que realizar alguns pré-processos para preparar as 3 imagens raster que
necessitamos na metodologia (RFS, CPC e ROIs). E necessario verificar que todas as imagens tenham os
mesmos limites geogréaficos e a mesma resolugdo. Em nosso caso, o objetivo é levar todo ao limite geogréafico do
produto RFS, mas escolheremos uma resolugéo intermédia entre os produtos (RFS 4km, CPC 0.5 graus) de 0.25
graus.

Para facilitar o exercicio, a imagem das areas de interesse (ROI) ja se encontra fornecida no sistema de
coordenadas e a resolucdo adequada. Esta imagem de ILWIS néo é outra coisa que um “class map” onde cada
categoria representa a uma bacia hidroldgica.

As imagens de RFS sdo descarregadas pelos usudrios a razdo de 1 cada 15 min., devido a isto necessitam ser
integradas em uma imagem didria. Um ponto importante a considerar nesta etapa é a hora de inicio/fim da
integracdo diaria, uma vez que esta deve ser a mesma para a estimativa por satélite como para a estimativa
pluviométrica. Em nosso exemplo, para América do Sul, o periodo de integragéo diaria de hoje comegaria desde
ontem as 12hs15min UTC até hoje as 12hs00min UTC. As unidades do produto RFS sdo mm/h e o procedimento
para sua integracdo diaria é: calcular a média para todas as imagens obtidas no dia e multiplica-la por 24. Assim
podem-se distribuir os erros provocados pela falta de imagens, algo que é muito comum neste tipo de produtos
com resolucdo de 15 min. Para realizar a integracdo é possivel estabelecer um processo automatico sobre o fluxo
em tempo real do satélite, ou podem-se aplicar processamentos por lotes em séries de dados arquivados.

Neste exercicio ja providencia-se uma imagem RFS diaria do dia 3 de janeiro de 2011, chamada
“hydro_20110103".

11.5.2. Maos a obra

Descomprima e copie os dados do exercicio em um diretdrio, inicie ILWIS e usando seu navegador abra o
diretério de trabalho. Reinicie ILWIS (fechar e abrir o programa) para que este se transforme em um novo
diretério ativo. No catdlogo da janela principal de ILWIS deveria observar um mapa intitulado
“hydro_20110103".

Faca doble clique sobre o nome para abri-lo e utilize como Representation a op¢do “mpe_sum” e pressione
“OK”. Explore a imagem com o botdo esquerdo pressionado, observe os valores e inspecione o sistema de
coordenadas usado na representacdo. Faga doble clique no botdo “Properties” que se encontra na janela da
legenda a esquerda da imagem. Adicione uma camada com os limites dos paises chamada “country_02”, use as
opcoes “Info off” e “Boundaries Only”. Observara que a por¢do sul do Chile e Argentina ndo tem dados. Isso é
devido a que este produto apenas permite estimar precipitacdo até os 45 graus de latitude Sul.

O préximo passo é mudar a resolugdo desta imagem (4km) a resolugdo de 0.25 graus que € nosso objetivo para o
produto final. Isto realiza-se utilizando a op¢do “Resample” que estda no menu principal de ILWIS dentro de:
“Operations” > “Spatial Reference Operations” > “Raster”. Os atributos que serdo utilizados nesta operagao de
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Resample podem ser observados na figura 11.2 (esquerda) e o resultado esperado deve ser como é mostrado na
figura 11.2 (direita). Realize a operacéo e contraste os resultados.

Baster Map | B hydro_20110103 |

GeoR eference Comers “hydro_org"”

Walue Bange: Minirurm: 0.000 b axirmurn:
BReszampling Method

+ Mearest Meighbour

" Bilinear

" Bicubic

Output Raster Map |hydloestimator_ﬂ25|
GeoReference | 3 Sudamenca_0_25 jJ

GeoReference from CuencazSudamer025_mod.rst, using GDAL

Value Rargs [0.000 | [212436 |

Precigion 0.000000

Diescription:

Define | Cancel | Help

Figura 11.2 Resample da imagen RFS. Atributos e resultados.

Os dados do CPC podem ser descarregados via ftp (vide o endere¢o encima) e as imagens devem ser pré-
processadas para atingir a mesma resolucdo de pixel e limites geogrficos do que a imagem RFS criada
recentemente (hydroestimator_025). As imagens do CPC tém uma resolucdo espacial de 0.5 graus e uma
cobertura global, para este exercicio apenas nos interessa a regido de América do Sul com uma resolugéo de 0.25
graus. Se vocé tem conexao a internet neste momento, é possivel ao site ftp do CPC e descarregar os dados
correspondentes ao dia deste exercicio. Na pasta RT (Real-Time, tempo real é o produto a partir do ano 2006)
vocé deveria encontrar o arquivo “PRCP_CU_GAUGE_V1.0GLB_0.50deg.Inx. 20110103.RT”. No caso de ndo
ter conexdo a internet existe uma cdpia deste arquivo na sua pasta de trabalho.

O procedimento necessario para importar esta imagem a um GIS precisa de uma observagao cuidadosa dos meta-
dados tipos do CPC:

e O formato do arquivo é binario, real (float) e seus valores estdo codificados em little Endian byte order
(no “swap”) onde undefine/sem dados é igual a -999.0;

e header size = 0, os dados estdo armazenados com uma sequéncia de bandas acorde a uma estrutura de
arquivo BSQ;

e NUmero de Filas / Colunas = 360/ 720;

e Sistema de coordenadas geogréficas Lat/Long WGS84 con latitude minima / méxima dos cantos -90 /
90; Longitude minima / maxima dos cantos 0 / 360;

e Numero de bandas = 2: Rain = Precipitacdo (prcp) = produto das analises de interpolagdo pluviométrica
(0.1mm/dia); e Gnum = Numero de esta¢des pluviométricas consideradas no pixel (gauges).
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E certo que na versdo mais atual de ILWIS vocé pode inserir muitas mais op¢des na linha de controle para
importar um arquivo raster genérico, mas por enquanto insira o seguinte comando para importar ambas camadas
do produto de CPC:

cpc_temp:=maplist(prcp_cu_gauge_v1.0glb_0.50deg.Inx.20110103.rt,genras,Convert,720,2,0,BSQ,Rea
1,4,NoSwap,CreateMpr)

Uma vez realizada a importacdo, aparece um “maplist” de ILWIS, se abre o maplist “cpc_temp” observara que
estd formado por 2 arquivos ou bandas. Agora, abra a banda “cpc_templ”, utilizando como Representation a
paleta “Pseudo”, esta operagao deveria mostrar um mapa como 0 mapa da figura 11.3.

[ cpc_temp1: Map cpc_temp1 imported from E:\block2_2012new' CoSch'prcp_cu_gai = IEIIﬂ

File Edit Layers Options Help

EEERIONNEEC .

EiRAER cpe_templ - Map
: Propetties

-999,000
-429.961

|754,39¢ | Mo Coordinates v

Figura 11.3 Camada de precipitagdo resultante da importacdo do CPC gauge data

As camadas do CPC estdo escritas para ser lidas de Oeste a Este e de Sul a Norte, mas a maioria dos pacotes de
software modernos utilizam o método standard de leitura Norte — Sul. Clique com o botdo direito do mouse
sobre 0 nome da camada aberta recentemente “cpc_templ”, no menu contextual que aparece selecione a opgéo
“Spatial Reference Operations” > “Raster” > “Mirror Rotate”, escolha a forma “Mirror Horizontal” e
especifique 0 nome de saida como “cpc_templ_mirror”. Aparecerd um mapa como o mapa da figura 11.4.

[ cpc_temp1_mirror: MapMirrorRotate{cpc_templ.mpr,MirrHor) - ILWIS . =] ]

File Edit Layers Options Help

|DDO [k O &

Properties
¥ Legend

=
1277156

[348,227 | Mo Coordinates 4

Figura 11.4 Camada de precipitacéo resultante da operacéo Mirror Rotate - Mirror Horizontal
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Algo importante que deve observar é que as camadas que abrimos do CPC ndo possuem um sistema de
coordenadas associadas “No Coordinates”. Também, observe a estranha posi¢do dos continentes neste mapa
mundial.

Antes de comecar com a geo-referenciacdo repita o procedimento de rotagdo para a banda 2: “cpc_temp2” e
observe como se distribuem as estagBes no mundo. Para visualizar o mapa utilize a paleta “Inverse” realizando
um strech de “0” a “1”.

Caso deseje explorar outro método para realizar a operacdo desejada pode revisar qual foi a linha de comando
que utilizou ILWIS ao executar do menu contextual a operacdo anterior, e depois, pode altera-la para fazer um
novo comando: cpc_temp2_mirror.mpr:=MapMuirrorRotate(cpc_temp2,MirrHor)

[ cpc_tempZ_mirror: MapMirrorRotate{cpc_temp2.mpr,MirrHor) - ILWIS . =] ]

File Edit Layers Options Help

EEEN NN EEC ] o]

=1ikA B cpc_tempz_mirro
Properties
Legend

-[Jo.000
[ Jo.zso
o500

4

Figura 11.5 Camada de Esta¢des pluviométricas depois de executar Mirror Rotate - Mirror Horizontal

Agora vamos geo-referénciar, estes 2 mapas, 0 que representa um desafio extra devido a que o sistema de
coordenadas global usado normalmente esté preparado para encontrar o continente americano a esquerda (Oeste)
e Europa-Africa a direita (Este). Mesmo que para este exercicio apenas seja necessario América do Sul, vocé vai
aprender a geo-referénciar todo o globo. O método para fazer isso de uma maneira mais facil é; Cortar as tiras
em hemisfério oriental e hemisfério ocidental e inverter a disposi¢éo atual.

Selecione a opcdo "U Mapa" do menu "Operacfes'> "OperacgOes Espaciais de Referéncia"> "Raster". Para cortar
os hemisférios das bandas de precipitacéo (templ) e estacdes de chuva (temp2), ler e usar as especificacdes
constantes nas imagens a seguir (Figura 11.6)

Selecione a opgdo “Sub Map” do menu “Operations” > “Spatial Reference Operations” > “Raster”. Para cortar
os hemisférios das bandas de precipitacdo (templ) e de estacfes pluviométricas (temp2), primeiro leia e depois
utilize as especificacbes que se indicam nas imagens a seguir (figura 11.6)
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& Sub Map of Raster Map I 2.3 I E# Sub Map of Raster Map >
Fiaster Map |ﬁ cpec_templ_irror j Fiaster Map |ﬁ cpe_terpl_mirrar ﬂ
* Lines and Columns * Lines and Columns
" Comners " Comers
i i
First Line First Line
Firgt Calumn Firgt Calurn
Mumber of Lines Mumber of Lines
MWumber of Colurmng 360 Mumber of Colurnng 360
Output Raster kMap |c:pc:_temp1_east Output Raster bMap |cpc_temp1_west
Description: | Description;

Imput map iz not north-oniented Imput map iz not north-oriented
Show Define | Cancel | Help | Show Define | Cancel | Help

Figura 11.6 Criacdo de sub mapas com os hemisférios Este e Oeste

Verifique que 0s sub mapas resultantes estejam corretos. Observe que ha algo muito estranho na Austrélia, se é
gue ndo tinha observado esse detalhe: uma porcdo do pais parece ter desaparecido: isto é porque devido as
intensas enchentes de esse momento ndo se obtiveram dados para essa area. Sempre verifiqgue em detalhe o
resultado de cada operacdo que realize. Uma oportuna inspeccdo visual lhe poupara tempo e evitara conclusdes
erradas. Neste caso a falta de dados em Australia ndo afeta o nosso resultado porque ndo pertence a nossa area de

estudio.

Para nosso prdximo passo, juntar ambos hemisférios na disposi¢do standard, primeiramente geo-referénciaremos
cada hemisfério por separado e depois, utilizaremos a opgdo de concatenar por coordenadas com o fim de
conseguir que o meridiano de Greenwich fique no centro de nosso mapa. O primeiro passo de nosso plano
requer que criemos 1 sistema de coordenadas para cada hemisfério, para fazer isso selecione do menu de ILWIS
a opcao: “Create” > “GeoReference” e crie duas geo-referéncias chamadas “east” e“west”, veja os detalhes na

figura 11.7.
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Figura 11.7 Detalhe das geo-referéncias para os hemisférios Este (East) e Oeste (West)

Agora que criamos as geo-referéncias de cada hemisfério temos que atribui-las as imagens correspondentes.
Utilize o clique direito sobre o arquivo “cpc_templ_east”, e no menu contextual selecione a opgao “Properties”.
Na janela de propriedades selecione a aba “Dependency” e depois, pressione o botdo “Break Dependency Link”e
pressione “Yes” na janela de confirmagdo. Abra mais uma vez a janela de propriedades de “cpc_templ east” e
agora em “Georeference” selecione a geo-referéncia “east” e pressione “OK”. Para observar se atingimos o
resultado adequado, abra a imagem e superponha a imagem vetorial que contem os limites administrativos de
paises, “country_02”, utilizando para sua visualizagdo as opgdes “Info” off e“Boundaries Only”. Verifique os
resultados, e coloque especial atencéo a informacdo de coordenadas que se localizam na parte inferior direita da
janela de visualizagao.

Agora repita este procedimento para o hemisfério Oeste utilizando o mapa “cpc_templ_west”. Depois do que
vocé tinha logrado atribuir a georeferénciacéo e tinha verificado que coincide com os limites administrativos dos
paises, € momento de colar ambos mapas para obter um que contenha todo o globo. No menu principal de
ILWIS selecione a opgdo “Operations” > “Raster Operations” > “Glue Maps”. Como 1 e 2% mapa utilize
“cpc_templ_east” e “cpc_templ_west” respectivamente, e como geo-referéncia escolha “full_WtoE”; como
nome de saida (Output Raster Map) introduza “prcp_20110103”. Seus resultados se deveriam aproximar aos da
Figura 11.8.
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& prcp_20110103: MapGlue(full_WtoE.grf,cpc_templ_east,cpc_templ_weskreplace - | [m] ﬂ
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Figura 11.8 Mapa Final onde aparecem os campos de precipitacdo interpolados por o CPC.

Depois destas operagdes ja temos um mapa global dos campos de precipitacdo no formato tradicional. A préxima
tarefa é realizar o mapa global das estagcfes com dados para esse dia. Para isto, devera repetir 0s passos anteriores
sobre a imagem “cpc_temp2_mirror”. Como nome de saida da Gltima operacdo (Glue Maps) utilize
“gauges_20110103". Lembre-se de que para obter uma boa visualizacdo dos dados deste mapa deve utilizar a
representacdo “Inverse” e um stretch entre “0” e “1”.

Agora que temos ambos mapas na cobertura global e na resolucdo original, temos que recortar a area e a
resolugdo necessarias para nosso estudo. Este Gltimo passo do pre-processo requer que fagca um “resample” dos
mapas “prcp_20110103” e “gauges_20110103” para que tenham as mesmas caracteristicas de nosso
“hydro_20110103" (0.25 graus de resolugdo). Para fazer isto, lembre-se de aquilo que utilizou na figura 11.2
(esquerda) e denomine os mapas resultantes “prcp_20110103_025” e “gauges_20110103_025" respectivamente.

Na figura 11.9 aparecem os resultados desta operagdo. Observe também, que no mapa de precipitacdo as areas de
oceano foram classificadas como “?” (ndo-data) porque ai ndo ha medicGes ni interpolagdo de dados. Vocé
consegue fazer isso?

3 gauges_20110103_025: MapResample(gauges_20110103.mpr,Sudamerica =]
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Figura 11.9 Mapas finais de estagdes e precipitacées do CPC para nossa area e resolugdo de estudo.
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O pré-processamento terminou! Se vocé observa o diagrama de fluxo da figura 1, observara que estamos no
principio do processo e que temos todo 0 necessario para comegar!

Com certeza vocé ja observou que os valores do mapa “prcp_20110103_025" sdo bastante elevados para a
precipitacdo, isto é porque o valor original foi multiplicado por 10. Este € um procedimento habitual em produtos
de disseminagdo porque permite guardar em um arquivo o valor real 12,6 em um formato inteiro como 126 e
assim diminuir consideravelmente o tamanho de grandes bases de dados (Iembre-se que este detalhe era muito
importante e até necessario tempo atras). Depois, durante o exercicio mudaremos essa informag&o a seu valor
real original.

Antes de comecar com a nova série de calculos esclareceremos 0 processo e nossos objetivos. Os computos
necessarios nado serdo realizados passo a passo, utilizando a interface grafica, melhor utilizaremos um Script de
ILWIS. Um diagrama grafico do processo e sua imediata explicagdo se mostra na figura 11.10. As férmulas para
calcular as distorcOes estdo dadas nas equaciones 1 e 2.

i Add_hyd Rat_hyd
B I ~ Meanbias  |p1 [b1| [b2 |b2
. bl y 1 X x | x| x| x| |bllbl] |b2|[b2
T4 | [ ‘ 4 z x | x| x| x k‘l(eep< j
[ ] X X X X
X1z elx | x|x|x bl |b2
a ¢ Y1y f|b1|b1

Figura 11.10 Método para selecionar a menor distor¢io

Para comecar, apenas utilizaremos aqueles pixeis que tenham pelo menos uma estacdo de medicdo de
precipitacdo para esse dia (a). Lembremos que os mapas do CPC mudaram sua resolucdo de 0.5 graus para 0.25
graus, isto produz uma divisdo do pixel (b). O hidroestimador mudou sua resolucdo para 0.25 graus (c) por
agregacao. Calculam-se as imagens das 2 distor¢des (aditiva e proporcional) para as células de 0.25 graus (d) e
aplica-se um filtro para obter a distor¢cdo média para ambos casos (o qual pode extrapolar-se a um pixel vizinho
para acrescentar o tamanho da corre¢do) (e). Estes mapas de distorcdo média sdo os utilizados na correcgdo e
geram-se mapas do hidroestimador corrigidos por ambos métodos (Add e Rat). Um esquema em particular
(aditivo ou proporcional) sera selecionado para cada pixel, o critério € a menor diferencia entre o hidroestimador
corregido e a observagdo terrena (cpc_precipitation) (f). Aqueles pixeis que estejam nas areas onde ndo ha
estacdes ndo serdo afetados pelo método e se conservara o valor original do hidroestimador.

11.5.3. Calculo da distorcéo

Para realizar todos os cOmputos descritos entre os pontos 1 e 4 do fluxograma lhe propomos utilizar um script de
ILWIS chamado “bias” que estd na sua pasta de trabalho. Selecione o script “bias” do catalogo de arquivos e
abra-lo. Examine seu conteddo e interprete que tipo de operagdes serdo feitas em cada linha de comando, nesse
mesmo texto encontrard linhas com esclarecimentos adicionais para compreender alguns processos. Para
executar o script, pressione o icone de “Run Script” ™ e, na janela emersa de parametrizagdo, introduza os
mapas apropriados. Na 11.11 encontrard o exemplo e depois pressione OK para executar.
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L;'; Script "ben_bias™ x|

RFS rainfall | hydroestimator_025 -

CPCgauges [Egauges 20110103025 =]

CPC rainfall

QK ICan:eIl Help |

Figura 11.11 Parametros necessarios para executar o script “bias”

Uma vez finalizados os coémputos abra o mapa hidroestimador corrigido pela distor¢do aditiva, chamada
“hydro_add”, utilize como opc¢éo de visualiza¢do “mpe_sum”. Na janela de visualizacéo selecione a opgao “File”
> “Open Pixel Information” e da janela de Pixel Information selecione as opcdes “File” > “Add Map” e adicione
todos os mapas que foram calculados para obter o hidroestimador corrigido pelo Add:

e Mapas de Entrada: hydroestimator_025, gauges_20110103_025, prcp_20110103_025;
e Mapas originais do CPC: prcp_temp, gauge_boolean, prcp_masked,;

e Mapas de distor¢do: bias_add_temp, bias_add_for_sum, bias_add_for_count;

e Resultados do filtrado: add_sum and add_count;

¢ Distorcdo média: average_add and bias_add.

Mova o cursor com 0 mouse sobre o mapa “hydro_add” e observe os valores dos mapas intermédios. Isto Ihe
permitira auditar os cobmputos e melhorar sua compreensdo das operagdes realizadas pelos comandos do script.
Eventualmente pode utilizar a calculadora para comprobacdo adicional. Seus resultados deveriam ser
semelhantes a Figura 11.12.
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Figura 11.12 Mapas de distor¢do média (add e rat) e hidroestimadores corrigidos por ambas distor¢Ges
(hydro_add and hydro_rat maps)

Observamos que durante o processamento aumenta o tamanho da area afetada com uma determinada distorgéo,
vale dizer que o pixel original de uma estacdo tinha 0.5 graus e mudou em 4 pixeis de 0,25 graus, ara depois
adicionar um pixel extra e gerar uma area de 0.75 graus. Vocé pode utilizar a transparéncia para conseguir
visualizar os mapas “bias_add” e “bias_add_temp” na mesma janela e assim observar o efeito de filtro adicional
(vide figura 11.13). Com a resolugao de trabalho (0.25), este incremento é 0 menos incremento possivel que vocé
pode realizar da area de influéncia da estagdo terrena. Pensemos que uma area maior significa maior
continuidade dos campos de precipitacfes, um efeito muitas vezes procurado na visualizacdo de dados a grande
escala, mas que depende do fendmeno estudado. Agora, em busca de equilibrio, acreditamos que fazer uma
medicdo de um fendmeno como chuva usando uma &area de amostragem de 30 cm de didmetro e, em seguida,
distribuir esse valor como referéncia de uma area de 50 km de raio (cerca de 0,5 graus) ja é um enorme salto de
fé.
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Figura 11.13 Expansao da area de influéncia das estagdes pluviométricas.

11.5.4. Processo de decisdo e célculo do CoSch

Agora é o momento de determinar que método de corre¢do do hidroestimador apresenta a menor distor¢éo ou
diferencia em relacdo a medigBes terrestres, esclarecendo... N6s devemos saber qual das corregbes faz que o
hidroestimador se aproxime mais ao valor medido. Esta diferencia pode ser tanto positiva como negativa, mas de
qualquer forma queremos a menor. Para isso utilizaremos a funcdo ““abs™ de ILWIS que nos devolve o valor
absoluto de uma imagem ou operagéo.

O mapa de precipitacdo que devemos usar no processo de comparagdo é “prcp_masked”, devido a que é o mapa
gue tem apenas 0s pixeis que tém dados baseados na observacdo real (2x2 pixeis) e todo o interpolado é
eliminado. Porém se vocé se lembra, no processo anterior utilizamos um filtro para acrescentar a area de
correcdo em 1 pixel (3x3 pixeis). Neste momento vocé pode decidir qual é o tamanho da corre¢cdo com que
deseja continuar o calculo de CoSch final.

Caso prefira ndo utilizar dados interpolados até 0.75 graus e deseje conservar a resolugdo da informacgdo original
do CPC (0.50 graus), escreva as seguintes expressdes na linha de comandos de ILWIS:

diff_abs_add:=abs(prcp_masked-hydro_add)
diff_abs_rat:=abs(prcp_masked-hydro_rat)

Caso prefira manter o filtro de 3x3 para ganhar um pouco de maior continuidade no mapa final utilize os
seguintes comandos:

gauge_temp_mask:=MapFilter(gauge_boolean,RankOrder(3,3,9),value)
prcp_masked_big:=gauge_temp_mask * (prcp_temp/10)

diff_abs_add_big:=abs(prcp_masked_big-hydro_add)
diff_abs_rat_big:=abs(prcp_masked_big-hydro_rat)
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Visualize os mapas resultantes e explore os valores dos pixeis para compreender sua categoria. Agora temos as
diferencias absolutas entre ambas corre¢des e 0 observado, portanto, podemos selecionar a corre¢do que estd
mais proxima ao valor medido. Abaixo se exibe um exemplo utilizando os valores sem filtrar:

cosch_temp:=iff(diff_abs_add ge diff_abs_rat,abs(hydro_rat),abs(hydro_add))

Se vocé escolheu manter o filtro de 3x3 o se esta fazendo ambos para comparar resultados (o qual o apressenta
como um bom aluno), repita o procedimento com 0s nomes correspondentes e chame esse resultado

“cosch_temp_big”. Visualize os mapas utilizando como paleta de representagdo “mpe_sum” e explore os
resultados.

Agora apenas nos falta o Ultimo passo: conservar esse valor da melhor correcdo para pixeis proximos a uma
estacdo pluviométrica e agregar o valor de estimativa do satélite em aqueles pixeis que estdo afastados de um
ponto de control. Com as seguintes linhas atingiremos os mapas finais de nosso exercicio:

cosch:=ifundef(cosch_temp,hydroestimator_025)

cosch_big:=ifundef(cosch_temp_big,hydroestimator_025)

Seus resultados deveriam ser semelhantes a Figura 11.14, dependendo do filtro utilizado. Explore os valores dos
pixeis nas suas imagens. Lembre-se que é possivel sobrepor algumas delas para consultar a0 mesmo tempo 0s
valores originais e os valores das distintas corre¢fes. Outro exercicio consiste em realizar mapas para observar

qual dos esquemas de corre¢do (ADD ou RAT) foi selecionado em cada pixel e a distribuicdo espacial dessa
selecéo.

6 cosch: ifundef(cosch_temp,hydroestimator_025) - ILWIS
Flle Edit Layers Options Help

3 cosch_big: ifundef{cosch_temp_big hydroestimator_025) =1L _|Oj x|
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Figura 11.14 CoSch final, sem filtro (esquerda) e com o filtro de 3x3 (direita).
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Observe a Figura 11.15 que nos exibe uma interpolacéo pluviométrica e 2 estimativas de satélite diferente. Os
campos de precipitacdo das estimativas de satélites, ndo sdo tdo homogéneos como os interpolados de dados de
campo. Quanto maior é a area que usamos para calcular o BIAS, mais erros incorporam-se na corregao. Este fato
pode até provocar precipitaces negativas, o qual é impossivel e deve ser levado em conta.

=1 | I 1 | 1|
1 5 10 15 20 25 30 35 4 B0

Precipitacao (mm/dia)

Figura 11.15 Comparac&o entre interpolacéo pluviométrica e estimativas de satélites.

11.5.5. Calcular estatisticas para bacias ou regides de interesse.

Estes mapas ajudam bastante para muitas analises, ndo obstante as vezes apenas precisamos de valores sobre
uma area especifica de nosso interesse (ROI). Agora € 0 momento apropriado para abrir e explorar um dos mapas
providenciados, cujo nome é “Cuencas’, também é possivel observa-lo na Figura 11.16.

Observe que quando explora este mapa categorico com o botdo direito do mouse pressionado, aparecerd uma
etiqueta com 0 nome da bacia. Este mapa categdrico serd combinado com a nossa estimativa de precipitagdo
corrigida: o CoSch. O resultado sera uma tabela com as possiveis combinagdes de pixeis, suas frequéncias e a
sua érea.
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Figura 11.16 Mapa de tipos de ILWIS com as bacias maiores de América do Sul.

Desde 0 menu principal de ILWIS, selecione: “Operations” > “Raster Operations” >"Cross”, complete com os
detalhes providenciados na figura 11.17 e pressione “Show”. Ou, escreva 0 seguinte na linha de comando

principal:

Rain_basin_cross.tbt:=TableCross(Cuencas, cosch,IgnoreUndefs)

1st Map I Efh Cuencas
v lgnore Undefs

2nd Map I Efh cosch
v lgnore Undefs

Output Table |F|ain_basin_c:ross

Description:

[ Qutput Map

Show | Define | Cancel |

Figura 11.17 Detalhe do cruzamento

Abra a tabela “rain_basin_cross” e inspecione seu contetdo.

Uma coluna que nos vai ser Util mais para frente € aquela que tem valores de precipitagdes >=1, esta é uma
forma habitual de eliminar pixeis residuais e obter uma &rea de precipitacdo mais exata. A fungdo “iff” pode ser
usada em ILWIS dentro do contexto de tabelas, ou seja que vamos criar uma nova coluna “cosch_GE_1mm”,
introduzindo esta linha na linha de comando da TABELA (e ndo na linha principal de ILWIS):
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cosch_GE_1mm:=iff(cosch ge 1,cosch,?)

Agora vamos realizar o calculo da precipitagdo média areal para cada bacia. Para isto, vamos a criar uma nova
tabela “statistics”. Desde o0 menu de Tabela selecione “Columns” > “Aggregation”, e preencha os campos usando
de referéncia a figura 11.18, lembre-se de pressionar “OK”.

& seeconrs SN

Colurmn | [ cosch ﬂ

Function | fn Average ﬂ

W Group by | [ Cuencas ﬂ

W wieight | [ MPix ﬂ

W Dutput Table |Statistics |

Output ol

k. | Eancel| Help |

Figura 11.18 Calculo de estatisticas sobre as chuvas agregadas por bacias

Explore a tabela resultante “statistics” e os valores da média que se obtiveram. Lembre-se que para uma melhor
estimativa da area da tormenta € melhor usar a média, mas de pixeis >= 1mm. Agora, vamos a fazer estes
calculos desde a linha de comando principal de ILWIS, portanto deve fechar ambas tabelas.

Para calcular a precipitacdo média areal >=1 tente escrever a seguinte linha:

tabcalc statistics cosch_ge_1mm:=ColumnJoinAvg(Rain_basin_cross.tbt,cosch_GE_1 mm,
Cuencas,NPix)

Outro dado interessante é saber qual foi a precipitacdo maxima:

tabcalc statistics maximum:=ColumnJoinMax(Rain_basin_cross.tbt,cosch, Cuencas,1)

Finalmente, podemos obter a area da bacia normalizada na que a precipitagéo é >=1:

tabcalc rain_basin_cross.tbt NPix_GE_1mm:=iff(cosch ge 1,NPix,0)

crtbl Tabla_temp cuencas

tabcalc Tabla_temp sum_NPix:=ColumnJoinSum(Rain_basin_cross.tbt,NPix,Cuencas, 1)



PAGINA |20

tabcalc Tabla_temp sum_NPix_GE_1mm:=ColumnJoinSum(Rain_basin_cross.tbt,
NPix_GE_1mm,Cuencas,1)

tabcalc statistics area_GE_1mm:=Tabla_temp.tbt.sum_NPix_GE_1mm *100 /
Tabla_temp.tht.sum_NPix

N&o derivamos areas em ha ou km2 devido a que os mas ndo estdo projetados, mas para os fins da exercitagdo a
proporcao da bacia é suficiente. Se vocé conhece a area de seu ROI, é possivel obter a area utilizando esta
proporcao.

Parabéns! Sua tabela final deveria ser semelhante a tabela exibida na Figura 11.19. Também € interessante
observar o contelido da “Tabla_temp”.

fii Table "statistics" - ILWIS o ] 1|
File Edit Columns Records Yiew Help
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Figura 11.19 Estatisticas finais sobre as principais bacias de América do Sul.

Finalmente observe o contetdo do script de ILWIS chamado “script_auto_media”. Este Ihe permite rodar todo o
exercicio de forma “;-p” devido a isto é possivel utiliz&-lo para aprender a fazer o script e para copiar processos
deste exercicio que tenha interesse em automatizar ou reproduzir.

11.6. Conclusao

A metodologia apresentada neste exercicio aplica-se satisfatoriamente a Bacia do Rio de la Plata para melhorar
seu gerenciamento. E verdade que utilizam-se outras fontes de dados com mais alta resolugdo. Porém o
mecanismo é igual e é possivel sua reprodugdo em qualquer outro local. Neste caso foi adaptado para utilizar
produtos sem custo algum que sdo fornecidos por DevCoCast e 0 NOAA-CPC de forma livre. Entdo é preciso
um estudo mais detalhado para avaliar sua precisdo e suas limitagbes com esses conjuntos de dados. Tenha
sempre em mente que a exatiddo, precisdo e impacto da corre¢do sera estreitamente associado com a densidade



PAGINA |22

de esta¢Oes pluviométricas, o regime e o tipo de precipitacdo dominante e tamanho das Regifes de Interesse. Por
isso resulta imprescindivel investigar este caso particular para conhecer a sua confiabilidade.

Por enquanto, a aplicacdo do esquema combinado corre¢cdo CoSch usando estimativas de satélites e dados de
precipitacdo, é bastante simples utilizando esta metodologia em um software livre como € o llwis.
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